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Course contents

• Overview: Goodbye, calculator

• Lesson 1: Get started

• Lesson 2: Use cell references

• Lesson 3: Simplify formulas by using functions

Each lesson includes a list of suggested tasks and a set of 

test questions.
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Overview: Goodbye, calculator

Excel is great for working with 

numbers and math. In this course 

you’ll learn how add, divide, multiply, 

and subtract by typing formulas into 

Excel worksheets.

You’ll also learn how to use simple 

formulas that automatically update 

their results when values change. 

After picking up the techniques in this 

course, you’ll be able to put your 

calculator away for good. 
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Course goals

• Do math by typing simple formulas to add, divide, multiply, 

and subtract. 

• Use cell references in formulas, so that Excel can 

automatically update results when values change or when 

you copy formulas. 

• Use functions (prewritten formulas) to add up values, 

calculate averages, and find the smallest or largest value in 

a range of values. 



Lesson 1

Get started
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Get started

Imagine that Excel is 

open and you’re 

looking at the 

“Entertainment” 

section of a household 

expense budget.

Cell C6 in the worksheet is empty; the amount spent 

for CDs in February hasn’t been entered yet.

In this lesson, you’ll learn how to use Excel to do basic 

math by typing simple formulas into cells. You’ll also 

learn how to total all the values in a column with a 

formula that updates its result if values change later. 
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Begin with an equal sign

The two CDs 

purchased in February 

cost $12.99 and 

$16.99.

The total of these two values is the CD expense for the 

month. 

You can add these values in Excel by typing a simple 

formula into cell C6.
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Begin with an equal sign

The picture illustrates 

what to do. 

1 Type a formula in cell C6. Excel formulas always begin 

with an equal sign. To add 12.99 and 16.99, type:

=12.99+16.99

The plus sign (+) is the math operator that tells Excel to 

add the values. 
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Begin with an equal sign

The picture illustrates 

what to do. 

2

3

Press ENTER to display the formula result.

If you wonder later how you got this result, you can click 

in cell C6 any time and view the formula in the formula 

bar near the top of the worksheet.
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Use other math operators

To do more than add, 

use other math 

operators as you type 

formulas into 

worksheet cells. 

Excel uses familiar 

signs to build 

formulas. 

As the table shows, use a minus sign (-) to subtract, an 

asterisk (*) to multiply, and a forward slash (/) to divide. 

Remember to always start each formula with an equal 

sign.

Math operators

Add (+) =10+5

Subtract (-) =10-5

Multiply (*) =10*5

Divide (/) =10/5
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Total all the values in a column

To add up the total of 

expenses for January, 

you don’t have to type 

all those values again.

Instead, you can use a 

prewritten formula 

called a function. 

1

2

On the Home tab, click the Sum button       in the 

Editing group.

To get the January total, click in cell B7 and then:

A color marquee surrounds the cells in the formula, and 

the formula appears in cell B7. 
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Total all the values in a column

To add up the total of 

expenses for January, 

you don’t have to type 

all those values again.

Instead, you can use a 

prewritten formula 

called a function. 

3 Press ENTER to display the result in cell B7: 95.94. 

To get the January total, click in cell B7 and then:

Click in cell B7 to display the formula =SUM(B3:B6) in 

the formula bar. 

4
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Total all the values in a column

B3:B6 is the 

information, called the 

argument, that tells 

the SUM function what 

to add. 

By using a cell reference (B3:B6) instead of the values in 

those cells, Excel can automatically update results if 

values change later on. 

The colon (:) in B3:B6 indicates a cell range in column B, 

rows 3 through 6. The parentheses are required to 

separate the argument from the function.
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Copy a formula instead of creating a new one

Sometimes it’s easier 

to copy formulas than 

to create new ones. 

In this section, you’ll see how to copy the formula you 

used to get the January total and use it to add up 

February’s expenses. 
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Copy a formula instead of creating a new one

First, select cell B7.

Next, as the picture shows:

Then position the 

mouse pointer over 

the lower-right corner 

of the cell until the 

black cross (+) 

appears.

Drag the fill handle from cell B7 to cell C7, and 

release the fill handle. The February total 126.93 

appears in cell C7.

The formula =SUM(C3:C6) will also become visible in 

the formula bar near the top of the worksheet.

1
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Copy a formula instead of creating a new one

First, select cell B7.

Next, as the picture shows:

Then position the 

mouse pointer over 

the lower-right corner 

of the cell until the 

black cross (+) 

appears.

The Auto Fill Options button      appears to give you 

some formatting options. In this case, you don’t need 

formatting options, so no action is required. The button 

disappears when you next make an entry in the cell. 

2



Enter formulas

Suggestions for practice

1. Create a formula for addition.

2. Create other formulas. 

3. Add up a column of numbers.

4. Add up a row of numbers.



Lesson 2

Use cell references
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Use cell references

Cell references

identify individual cells 

or cell ranges in 

columns and rows. 

Cell references tell 

Excel where to look 

for values to use in a 

formula. 

Excel uses a reference style called A1, which refers to 

columns with letters and to rows with numbers. The 

numbers and letters are called row and column headings. 

This lesson shows how Excel can automatically update the 

results of formulas that use cell references, and how cell 

references work when you copy formulas.

Cell references Refer to values in

A10 the cell in column A and row 10

A10,A20 cell A10 and cell A20

A10:A20 the range of cells in column A and rows 10 

through 20

B15:E15 the range of cells in row 15 and columns B 

through E

A10:E20 the range of cells in columns A through E and 

rows 10 through 20
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Update formula results

Suppose the 11.97 

value in cell C4 was 

incorrect. A 3.99 video 

rental was left out.

Excel can 

automatically update 

totals to include 

changed values. 

To add 3.99 to 11.97, you would click in cell C4, type the 

following formula into the cell, and then press ENTER:

=11.97+3.99



Enter formulas

Update formula results

As the picture shows, 

when the value in cell 

C4 changes, Excel 

automatically updates 

the February total in 

cell C7 from 126.93 to 

130.92. 

Excel can do this because the original formula 

=SUM(C3:C6) in cell C7 contains cell references.

If you had entered 11.97 and other specific values into a 

formula in cell C7, Excel would not be able to update the 

total. You’d have to change 11.97 to 15.96 not only in 

cell C4, but in the formula in cell C7 as well.
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Other ways to enter cell references

You can type cell 

references directly into 

cells, or you can enter 

cell references by 

clicking cells, which 

avoids typing errors.

In the first lesson you saw how to use the SUM function 

to add all the values in a column. 

You could also use the SUM function to add just a few 

values in a column, by selecting the cell references to 

include.
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Other ways to enter cell references

Imagine that you want 

to know the combined 

cost for video rentals 

and CDs in February.

1

2

In cell C9, type the equal sign, type SUM, and type an 

opening parenthesis. 

Click cell C4. The cell reference for cell C4 appears in 

cell C9. Type a comma after it in cell C9.

The example shows 

you how to enter a 

formula into cell C9 by 

clicking cells.   
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Other ways to enter cell references

Imagine that you want 

to know the combined 

cost for video rentals 

and CDs in February.

Click cell C6. That cell reference appears in cell C9 

following the comma. Type a closing parenthesis after it.

The example shows 

you how to enter a 

formula into cell C9 by 

clicking cells.  

Press ENTER to display the formula result, 45.94. 

3

4

A color marquee surrounds each cell as it is selected 

and disappears when you press ENTER to display the 

result. 
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Other ways to enter cell references

Here’s a little more 

information about how 

this formula works. 

The arguments C4 and C6 tell the SUM function what 

values to calculate with. The parentheses are required to 

separate the arguments from the function. 

The comma, which is also required, separates the 

arguments.
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Reference types

Now that you’ve 

learned about using 

cell references, it’s 

time to talk about the 

different types.

The picture shows two 

types, relative and 

absolute. 

1 Relative references automatically change as they’re 

copied down a column or across a row. 

When the formula =C4*$D$9 is copied from row to row 

in the picture, the relative cell references change from 

C4 to C5 to C6.
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Reference types

Now that you’ve 

learned about using 

cell references, it’s 

time to talk about the 

different types.

The picture shows two 

types, relative and 

absolute. 

Absolute references are fixed. They don’t change if you 

copy a formula from one cell to another. Absolute 

references have dollar signs ($) like this: $D$9. 

2

As the picture shows, when the formula =C4*$D$9 is 

copied from row to row, the absolute cell reference 

remains as $D$9.
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Reference types

There’s one more type 

of cell reference.

For example, $A1 is an absolute reference to column A 

and a relative reference to row 1. 

As a mixed reference is copied from one cell to another, 

the absolute reference stays the same but the relative 

reference changes.

The mixed reference

has either an absolute 

column and a relative 

row, or an absolute 

row and a relative 

column.
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Using an absolute cell reference

You use absolute cell 

references to refer to 

cells that you don’t 

want to change as the 

formula is copied. 

References are relative by default, so you would have to 

type dollar signs, as shown by callout 2 in the picture, to 

change the reference type to absolute.
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Using an absolute cell reference

Say you receive some 

entertainment 

coupons offering a 

7 percent discount for 

video rentals, movies, 

and CDs. How much 

could you save in a 

month by using the 

discounts? 

You could use a formula to multiply those February 

expenses by 7 percent. 

So start by typing the discount rate .07 in the empty cell 

D9, and then type the formula in cell D4. 
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Using an absolute cell reference

Say you receive some 

entertainment 

coupons offering a 

7 percent discount for 

video rentals, movies, 

and CDs. How much 

could you save in a 

month by using the 

discounts? 

1

2

Then in cell D4, type =C4*. Remember that this relative 

cell reference will change from row to row.

Enter a dollar sign ($) and D to make an absolute 

reference to column D, and $9 to make an absolute 

reference to row 9. Your formula will multiply the value in 

cell C4 by the value in cell D9. 
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Using an absolute cell reference

Say you receive some 

entertainment 

coupons offering a 

7 percent discount for 

video rentals, movies, 

and CDs. How much 

could you save in a 

month by using the 

discounts? 

Cell D9 contains the value for the 7 percent discount.3

You can copy the formula from cell D4 to D5 by using 

the fill handle. As the formula is copied, the relative cell 

reference changes from C4 to C5, while the absolute 

reference to the discount in D9 does not change; it 

remains as $D$9 in each row it is copied to.
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Suggestions for practice

1. Type cell references in a formula.

2. Select cell references for a formula. 

3. Use an absolute reference in a formula.

4. Add up several results.

5. Change values and totals. 



Lesson 3

Simplify formulas by using 

functions
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Simplify formulas by using functions

Function names 

express long formulas 

quickly. 

As prewritten 

formulas, functions 

simplify the process of 

entering calculations. 

Using functions, you can easily and quickly create 

formulas that might be difficult to build for yourself.

SUM is just one of the many Excel functions. In this 

lesson you’ll see how to speed up tasks with a few 

other easy ones.

Function Calculates

AVERAGE an average

MAX the largest number

MIN the smallest number
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Find an average

You can use the 

AVERAGE function to 

find the mean average 

cost of all 

entertainment for 

January and February. 

Excel will enter the 

formula for you. 

Click in cell D7, and then:

1

2

On the Home tab, in the Editing group, click the arrow 

on the Sum button, and then click Average in the list.

Press ENTER to display the result in cell D7. 
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Find the largest or smallest value

The MAX function 

finds the largest 

number in a range, 

and the MIN function 

finds the smallest 

number in a range. 

The picture illustrates 

the use of MAX. 

1

2

Start by clicking in cell F7. Then: 

On the Home tab, in the Editing group, click the arrow 

on the Sum button, and then click Max in the list. 

Press ENTER to display the result in cell F7. The largest 

value in the series is 131.95.  
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Find the largest or smallest value

The MAX function 

finds the largest 

number in a range, 

and the MIN function 

finds the smallest 

number in a range. 

The picture illustrates 

the use of MAX. 

To find the smallest value in the range, you would click 

Min in the list and press ENTER.

The smallest value in the series is 131.75.
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Print formulas

You can print formulas 

and put them up on 

your bulletin board to 

remind you how to 

create them.

But first, you need to 

display the formulas 

on the worksheet. 

Here’s how: 

1. Click the Formulas tab.

2. In the Formula Auditing group, click Show 

Formulas      . 
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Print formulas

You can print formulas 

and put them up on 

your bulletin board to 

remind you how to 

create them.

But first, you need to 

display the formulas 

on the worksheet. 

Here’s how: 

3. Click the Microsoft Office Button in the upper-

left corner of the Excel window, and click Print.

Tip: You can also press CTRL+` to display and 

hide formulas.
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What’s that funny thing in my worksheet?

Sometimes Excel 

can’t calculate a 

formula because the 

formula contains an 

error.

If that happens, you’ll 

see an error value in a 

cell instead of a result.

• #### The column isn’t wide enough to display the 

contents of the cell. To fix the problem, you can 

increase column width, shrink the contents to fit the 

column, or apply a different number format. 

Here are three common error values:
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What’s that funny thing in my worksheet?

Sometimes Excel 

can’t calculate a 

formula because the 

formula contains an 

error.

If that happens, you’ll 

see an error value in a 

cell instead of a result.

• #REF!   A cell reference isn’t valid. Cells may have 

been deleted or pasted over. 

Here are three common error values:

• #NAME? You may have misspelled a function name 

or used a name that Excel doesn’t recognize.  
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Find more functions

Excel offers many 

other useful functions, 

such as date and time 

functions and 

functions you can use 

to manipulate text. 

1. Click the Sum button in the Editing group on the 

Home tab.

2. Click More Functions in the list. 

3. In the Insert Function dialog box that opens, you 

can search for a function.

To see all the other functions:
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Find more functions

Excel offers many 

other useful functions, 

such as date and time 

functions and 

functions you can use 

to manipulate text. 

In addition to searching for a function in this dialog box,  

you can select a category and then scroll through the list 

of functions in the category. 

And you can click Help on this function at the bottom 

of the dialog box to find out more about any function.
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Suggestions for practice

1. Find an average.

2. Find the largest number.

3. Find the smallest number.

4. Display and hide formulas. 

5. Create and fix error values. 

6. Create and fix the error value #NAME?.


